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Important information
Before you install and use your SMART Board™ X800 series interactive whiteboard, 

read the following warnings carefully. Failure to read the warnings below, or to follow 

the installation instructions included with your SMART product could result in personal 

injury or product damage.

NOTE

In this document, the term “interactive whiteboard” refers to your interactive 

whiteboard and its accessories and options.

WARNINGS

• Ensure that any cables extending across the floor to your SMART product are 

properly fastened together and marked to avoid a trip hazard.

• To reduce the risk of fire or electric shock, do not expose your SMART product 

to rain or moisture.

• Refer to the safety warnings and precautions published by the projector 

manufacturer. Do not stare (or allow children to stare) directly into the 

projector’s beam of light.

• Do not touch (or allow children to touch) your projector because it can 

become extremely hot during normal operation.

• Do not stand (or allow children to stand) on a chair to touch the surface of 

your SMART product. Instead, safely fix the product at the appropriate height 

on a wall or use a SMART height-adjustable floor stand.

• Do not climb (or allow children to climb) on a wall- or stand-

supported SMART Board interactive whiteboard. 

• Two people are required to safely mount your interactive 

whiteboard because it is too heavy for one person to safely 

maneuver. When you and your assistant lift your interactive whiteboard, 

support its weight at the bottom, avoiding the corner cameras, and balance 

the top with your other hands.
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• To prevent injury or product and property damage, use only the mounting 

hardware supplied with your SMART Board X800 series interactive 

whiteboard when you install your product on drywall. The mounting hardware 

provided with other interactive whiteboards may not be strong enough to 

support the weight of SMART Board X800 series interactive whiteboards.

• Use two wall-mounting brackets to install SMART Board interactive 

whiteboards with a diagonal width of 87" (221 cm) or more. 

• For operating safety and to prevent damage to your interactive whiteboard, 

connect its USB connector, or SMART connection extenders, only to a 

computer that has a USB compliant interface and that bears the USB logo. In 

addition, the USB source computer must be compliant with CSA/UL/EN 

60950 and bear the CE mark and CSA and/or UL mark(s) for CSA/UL 60950.

• To prevent injury or product damage as a result of tipping, mount your 

interactive whiteboard only on a floor stand that is certified for use with 

SMART Board X800 series interactive whiteboards, such as the SMART 

FS670 Mobile Floor Stand or SMART HAWM FS-UX Mobile Floor Stand. Do 

not modify your interactive whiteboard or your floor stand to make them 

compatible.

• Move a floor stand-supported SMART Board interactive whiteboard with care. 

Sudden stops, excessive force and uneven surfaces may cause the product 

to overturn. 

CAUTIONS

• If you need to lean your interactive whiteboard against a wall, make sure that 

it remains in an upright position, resting on its pen tray brackets, which are 

designed to sustain your interactive whiteboard’s weight. Do not rest your 

interactive whiteboard on its side, on the top of its frame or on the corners of 

the frame where the cameras are located.

• Do not add any extra weight or excessive pressure to a wall-mounted 

interactive whiteboard or its pen tray. SMART designed the brackets to 

support only the weight of your interactive whiteboard and its accessories 

during normal use. 

• There are no user-serviceable parts inside the pen tray. Only qualified 

personnel should disassemble the pen tray’s printed circuit boards, using 

proper electrostatic discharge (ESD) protection.

• When transporting your SMART Board interactive whiteboard, repack it with 

as much of the original packaging as possible. This packaging was designed 

with optimal shock and vibration protection.

• Do not use compressed air to clean the interactive whiteboard’s cameras 

because the force of the air could damage them.
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• Do not allow cleaner to flow onto the reflective strips at the edges of the 

interactive whiteboard’s frame, or into the pen tray slots.

• Do not set up and use your interactive whiteboard in an area with excessive 

levels of dust, humidity or smoke.

• If your SMART Board interactive whiteboard requires replacement parts, 

make sure that the service technician uses replacement parts specified by 

SMART Technologies or parts with the same characteristics as the original.

Other precautions
If you own a SMART product other than a SMART Board X800 series interactive 

whiteboard, refer to the installation manual for your product for relevant warnings and 

maintenance instructions.
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Chapter 1

About your SMART Board 
X800 series interactive 
whiteboard

Your SMART Board X800 series interactive whiteboard is the most advanced and 

intuitive touch sensitive, front projection interactive whiteboard in the world, featuring 

SMART’s proprietary DViT™ (Digital Vision Touch) technology. Its modular and 

expandable hardware and software architecture enables you to do everything you can 

do at your computer—open and close applications, conference with others, create 

new documents or edit existing ones, visit websites, play and manipulate video clips 

and more—just by touching the interactive surface. Two users can also draw on the 

interactive surface at the same time, and you can use an array of gestures within 

applications.

You can also write over any application in digital ink using a pen tray pen or your 

finger, and then save these notes for future reference and distribution.

In this chapter
Refer to these topics to learn more about your SMART Board X800 series interactive 

whiteboard and for information about product parts and accessories.

Features................................................................................................. page 2

Understanding how your SMART Board interactive 

whiteboard works................................................................................... page 4

Included parts and accessories ............................................................. page 5
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Features
Your SMART Board X800 series interactive whiteboard 

includes the familiar features of other SMART Board 

interactive whiteboard series. In addition, it features the 

ability for two users to draw simultaneously over the 

entire interactive surface, enabling improved 

collaboration. The X800 series also features a modular 

pen tray design that makes it easy to add accessories.

The following models are available: 

• SBX880 and SBX880-MP—77" (195.6 cm) diagonal

• SBX885 and SBX885-MP—87" (221 cm) diagonal

Refer to the product specification sheets for specific product dimensions.

Your SMART Board X800 series interactive whiteboard
Use the illustration below to familiarize yourself with the components of your 

interactive whiteboard.

Pen color 

buttons

Pen tray buttons 

and indicators

Cameras

Interactive

surface
Pen tray 

Cameras

Eraser slot

Pen slot
Pen slot

Pen tray

Power 

module

Keyboard 

button

Right-click 

button
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Feature highlights

Software

To use all the features of your interactive whiteboard described in this guide, go to 

smarttech.com/downloads and ensure that you have the lastest version of SMART 

software and SMART Product Drivers installed on your computer.

Dual sketch capabilities

Two people can each pick up a pen and draw on the interactive surface at the same 

time, providing a higher degree of interactivity.

SMART Ink™

The SMART Ink feature smoothes out the appearance of the digital ink, which 

improves the legibility of your handwriting as you write over applications, websites and 

videos. The ink becomes an object that you can move and manipulate.

Touch and gestures

You can perform mouse functions with your finger, and write and erase digital ink with 

a pen tray pen or the eraser. The object awareness feature enables you to pick up a 

pen, and then write, select or erase without replacing the pen. 

Pen tray

The SMART Board X800 series interactive whiteboard features a modular pen tray 

with an intuitive new design. As well as two pens and an eraser, pen tray buttons 

activate the pen’s color, the on-screen keyboard, right-click, Orientation and Help 

functions.

Durable surface and dry erase

The hard-coated surface is scratch resistant, optimized for projection, compatible 

with dry-erase markers and easily cleaned.

Wall-mount bracket

Wall mount brackets enable you to install your SMART Board interactive whiteboard 

simply and securely.

Cables 

Connect your SMART Board interactive whiteboard to your computer with the 

included, standard USB cable, and to a wall outlet with the included power supply.

Security cable lock

Lock your interactive whiteboard with a security cable (not included) to help safeguard 

it from theft.

http://www.smarttech.com/downloads
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Understanding how your SMART Board 
interactive whiteboard works
Your interactive whiteboard functions as an input device for your computer, just like a 

mouse, enabling you to work in any application on your computer from your interactive 

whiteboard. 

When you touch your interactive whiteboard’s surface, the four cameras located in the 

interactive whiteboard’s corners detect the contact’s horizontal and vertical (or x,y) 

coordinates. Your computer interprets these coordinates and moves the pointer to the 

corresponding location on the interactive whiteboard’s surface. 

Other components
Using your interactive whiteboard requires 

two additional components: a computer and 

a digital projector. 

These components work together as follows:

• Your computer runs an application and 

sends the image to your projector.

• Your projector casts the image onto your 

interactive whiteboard.

• Your interactive whiteboard acts both as your computer’s monitor and its input 

devices, that is, its mouse and keyboard, enabling you to control any application 

by touching the interactive surface.

When you install SMART Product Drivers on your computer, the touch of your finger 

on the interactive surface becomes a mouse click, enabling you to control your 

computer from your interactive whiteboard. When you use a pen from the pen tray, the 

system detects which tool you’re using. SMART Product Drivers then interacts with 

the computer’s mouse driver to change the pointer to a colored pen, enabling you to 

write in digital ink on your desktop or any open application. When you use the eraser, 

you can erase the digital ink. You can even use your finger on the interactive 

whiteboard’s surface without returning the pen tray tools—automatic object 

awareness determines the tool you’re using on the interactive surface. You can also 

save your notes to a .notebook file, or directly into any Ink Aware application.
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Included parts and accessories
Your SMART Board X800 series interactive whiteboard includes the following 

accessories. 

Pens
There are two pens included with your interactive whiteboard. Pick up a pen and press 

one of the four color buttons on the pen tray (black, red, green or blue) to change the 

color of digital ink you write with on the interactive whiteboard. 

Eraser 
The eraser is rectangular like a traditional chalkboard 

eraser.

SMART Board interactive whiteboard wall-mounting kit
The 32" (81.3 cm) wall-mount bracket comes with five screws and toggle bolts, 

enabling you to wall-mount your interactive whiteboard simply and securely. Model 

SBX885 comes with two wall-mounting kits.

SMART USB cable
A 16' 5" (5 m) USB cable enables you to connect your 

SMART Board X800 series interactive whiteboard to a 

USB receptacle on your computer.

Power supply
The SMART Board X800 series interactive whiteboard receives power from a wall 

outlet through the included country-specific power supply and cable.

Optional accessories
You can add a variety of optional accessories to your SMART Board X800 series to 

best meet your specific needs. You can purchase these items when you order your 

interactive whiteboard, or later from your authorized SMART reseller. For more 

information about accessories, go to the SMART Board interactive whiteboard 

accessories page.

http://www.smarttech.com/us/Solutions/Education+Solutions/Products+for+education/Complementary+hardware+products/Accessories
http://www.smarttech.com/us/Solutions/Education+Solutions/Products+for+education/Complementary+hardware+products/Accessories
http://www.smarttech.com/us/Where+To+Buy
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Chapter 2

Installing and securing your 
SMART Board interactive 
whiteboard

In this chapter
Refer to these topics for information about mounting your SMART Board X800 series 

interactive whiteboard on a floor stand or on a wall.

Environmental requirements.................................................................. page 7

Installing your SMART Board interactive whiteboard ............................ page 8

Securing the pen tray and interactive whiteboard................................ page 10

Environmental requirements 
Before installing your interactive whiteboard, review the following environmental 

requirements.

Environmental 

requirement
Parameter

Operating temperature 41°F to 95°F (5°C to 35°C)

Storage temperature -40°F to 120°F (-40°C to 50°C)

Humidity 5% to 80% relative humidity, non-condensing

Water and fluid 

resistance

• Intended for indoor use only. Doesn’t meet any 

salt-spray or water ingress requirements.

• Don’t pour or spray liquids directly onto the interactive 

whiteboard or any of its sub-components. These liquids 

might get into areas where they could damage sensitive 

electronic components. Refer to page 30 for detailed 

instructions on cleaning your interactive whiteboard.
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Installing your SMART Board interactive 
whiteboard
Follow the procedure outlined in the installation document included in your interactive 

whiteboard’s box to install your interactive whiteboard. If you purchased a floor stand, 

wall-mount or an interactive whiteboard system that includes a projector or other 

components, refer to the installation documents included with these components.

The optimal mounting height is 77" (196 cm) from the floor to the center of the 

installation brackets. However, consider the general height of your user community 

when you choose a location for wall-mounting your interactive whiteboard. If you 

mount your interactive whiteboard too low, it might force tall people to bend over 

uncomfortably. If it’s too high, other people might need to reach up too far. Also 

remember to leave enough room on either side of the interactive whiteboard so that 

you can stand beside it. 

WARNINGS

• Two people are required to safely mount your interactive whiteboard because 

it is too heavy for one person to safely maneuver. When you and your 

assistant lift your interactive whiteboard, support its weight at the bottom, 

avoiding the corner cameras, and balance the top with your other hands.

• The weight of the interactive whiteboard is approximately 52 lb. (23.7 kg) for 

the SBX880 model and 61 lb. (27.5 kg) for the SBX885 model. Check your 

local building codes to ensure that your wall can support this weight, and use 

appropriate mounting hardware for your wall type.

Dust • Moderate dust. Intended for use in office and classroom 

environments. Not for industrial use where heavy dust 

and pollutants can cause malfunctions or impaired 

operation.

• Designed for pollution degree 1 (P1) as per EN61558-1, 

which is defined as “No pollution or only dry 

non-conductive pollution.”

Conducted and 

radiated emissions

EN55022/CISPR 22, Class A 

Environmental 

requirement
Parameter
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CAUTIONS

• If you need to lean your interactive whiteboard against a wall before you 

mount it, make sure that it remains in an upright position, resting on its pen 

tray brackets, which are designed to sustain your interactive whiteboard’s 

weight.

• Do not rest your interactive whiteboard on its side or on the top of its frame, or 

on the corners where the cameras are located. 

Installation Tips
• Ensure the bottom of the pen tray is unobstructed at all times, because you 

will need to access it if the interactive whiteboard requires service.

• Install your interactive whiteboard on a flat, plumb wall.

• If you’re installing the interactive whiteboard on drywall, use all the toggle 

bolts supplied. If one of the bracket holes aligns with a wall stud, use 

appropriate hardware in that hole instead of a toggle bolt.

• Ensure that the power cord is connected to the correct receptacle in the pen 

tray, as shown below.

Replacing a SMART Board interactive whiteboard on drywall
If you’re replacing a SMART Board 500 or 600 series interactive whiteboard with the 

heavier X800 series on drywall, you must remove the wall-mount bracket and 

mounting hardware, and then install all the mounting hardware and brackets supplied 

with your X800 series interactive whiteboard instead. 

CAUTION

To help ensure your interactive whiteboard is mounted correctly, make sure the 

color of the wall-mount hanger on the back of the interactive whiteboard and the 

wall-mount bracket are the same.

Power cord receptacle
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Securing the pen tray and interactive 
whiteboard
Because your SMART Board interactive whiteboard’s pen tray is detachable, you 

might want to safeguard it—and your interactive whiteboard—by anchoring it with a 

security cable (not included). Underneath the pen tray, you’ll find a lock slot that 

accommodates a security cable, such as a Kensington® lock.

IMPORTANT

Securing the pen tray can provide theft deterrence for your interactive whiteboard 

because the screws that secure your interactive whiteboard to the wall are located 

directly behind the pen tray, and cannot be removed without first detaching the 

pen tray. In effect, when you secure the pen tray, you also secure your interactive 

whiteboard if the security cable is tight.

To lock the pen tray

to your interactive

whiteboard

1. Loop your security cable behind the pen tray brackets before you secure them 

to the wall.

2. Thread the lock end of the cable through the loop end of the cable. 

3. Verify that the cable is tight enough that you can’t remove the pen tray while the 

lock is in place, and then install the pen tray. 

4. Insert the prong end of the security cable into the lock slot, and then complete 

the pen tray installation by locking it.

Securing the pen tray to the pen tray brackets 
Since you can remove the pen tray without tools, you might want to securely attach it 

to its brackets. To do this, insert two No. 8/M4 screws (not included) into the holes 

indicated by a lock symbol on the bottom of the pen tray.

Lock slot

Security screw holes
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Connecting your interactive 
whiteboard to your computer

In this chapter
Refer to these topics for information about connecting your SMART Board X800 

series interactive whiteboard to your computer.

Connecting the USB cable................................................................... page 11

Installing SMART Product Drivers ....................................................... page 12

Configuring your computer settings ..................................................... page 13

Calibrating your interactive whiteboard................................................ page 14

Orienting your interactive whiteboard .................................................. page 15

Connecting a guest laptop ................................................................... page 17

Your interactive whiteboard will be touch sensitive after you install SMART Product 

Drivers on your connected computer. Perform the brief calibration and user orientation 

procedures (see page 15) to ensure the interactive whiteboard interprets the location 

of your touch accurately.

Connecting the USB cable 
Your SMART Board interactive whiteboard has a USB 2.0 interface that runs at 

speeds of up to 12 Mbps. Your interactive whiteboard’s main USB connection is 

located on the bottom of the pen tray. The connector is a USB Type-B receptacle. The 

unit works with full-speed USB 2.0- and USB 1.1-compliant interfaces. 

WARNING

For operating safety and to prevent damage to your interactive whiteboard, 

connect its USB connector, or SMART connection extenders, only to a computer 

that has a USB compliant interface and that bears the USB logo. In addition, the 

USB source computer must be compliant with CSA/UL/EN 60950 and bear the 

CE mark and CSA and/or UL marks for CSA/UL 60950.
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This location provides access to the USB receptacle without having to remove your 

interactive whiteboard from the wall. 

To connect

the USB cable

1. Connect one end of the included USB cable to a USB A receptacle on your 

computer.

2. Connect the other end of the USB cable to your interactive whiteboard’s USB 

receptacle. Tuck the cable into the cable management slot on the bottom of the 

pen tray to prevent a tripping hazard.

3. Turn on your computer.

4. Install SMART Product Drivers.

Installing SMART Product Drivers
After you install SMART Product Drivers on your computer, your SMART Board 

interactive whiteboard’s surface will respond to the touch of your finger or a pen tray 

pen. SMART Product Drivers includes the tools you need to control computer 

applications with your finger or a pen, and to write over them in digital ink. 

NOTE

If you don’t install SMART Product Drivers, interactive whiteboard tools such as 

the pens and the eraser don’t work, but you can move the mouse pointer and 

perform mouse functions by touching the interactive surface.

To install

SMART Product Drivers

1. Download the SMART Product Drivers .exe (Windows) or .dmg (Mac) file to your 

computer from the disc or link included with your interactive whiteboard or from 

smarttech.com/downloads. 

USB Type-B 

receptacle

http://www.smarttech.com/downloads
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NOTE

In most cases, SMART Product Drivers is downloaded automatically when 

you install SMART Notebook™ or SMART Meeting Pro™ software.

2. If it’s not already on, turn on your projector to see the projected computer image 

on your interactive whiteboard. 

3. Locate the installation program and follow the on-screen instructions to complete 

the installation.

SMART Board Tools opens automatically.

4. If SMART Board Tools doesn’t open:

– If you have a Windows® computer, select Start > All Programs > 

SMART Technologies > SMART Product Drivers > SMART Board Tools 

– If you have a Mac computer, open Mac HD, and then select Applications > 

SMART Product Drivers > SMART Board Tools.app.

The Ready light in your interactive whiteboard’s pen tray turns from flashing green 

to solid green and the SMART software icon appears in the Windows notification 

area or Mac Dock, indicating that your interactive whiteboard is communicating 

successfully with SMART Product Drivers. 

You can now pick up a pen from the pen tray and write over your desktop or any 

projected application, and use all the other features of your SMART software. For 

more information on using your SMART software, press the SMART software icon and 

select Help.

Configuring your computer settings
For optimal configuration, use the following settings for the computer connected to 

your interactive whiteboard.

Recommended settings
Configure your computer’s power management settings to turn off the monitor after 

one hour of inactivity and to put the hard disks into standby mode after two hours. 

This extended period prevents the computer from shutting down unexpectedly 

(for example, during presentations or meetings that have gaps in computer activity).

Your computer will stop sending a video signal to your projector after a period of idle 

time, which may trigger the projector to go into standby mode. Similarly, you can put 

your projector in standby mode by following the manufacturer’s instructions included 

with your projector. To change the settings, see the instructions included with your 

operating system. 
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Matching your computer’s resolution to your projector’s 
resolution
Ensure that the resolution settings for your projector and computer match. If your 

computer’s resolution doesn’t match the projector’s native resolution, the image won’t 

appear correctly or will be distorted. See Getting the Best Image Quality on Your 

SMART Board Interactive Whiteboard (smarttech.com/kb/127199) for more 

information.

Determine your projector’s native resolution, indicated in your projector’s user’s guide, 

and then set your computer’s resolution to match. You can change your computer’s  

resolution in Windows Control Panel or in the Mac System Preferences. If you need 

further help changing your computer’s resolution, see the instructions included with 

your operating system.

You might also need to adjust your computer’s refresh rate to obtain the best results. 

Set the computer to an initial refresh rate of 60 Hz, and then adjust this rate up or 

down until you determine the ideal refresh rate. For more information on changing 

your computer’s refresh rate, see the instructions included with your operating 

system.

Calibrating your interactive whiteboard
Digital cameras in the corners of the interactive whiteboard track the position of the 

pens, eraser and your finger on the interactive surface, and then send the information 

to the SMART software, which interprets this information as mouse clicks, digital ink or 

ink removal in the appropriate location. 

The first time you connect your SMART Board interactive whiteboard, if you don’t see 

a pop-up bubble telling you to calibrate the interactive whiteboard, press the Help 

button on the pen tray to start the calibration process as described below. This 

process ensures that the cameras accurately track your finger and the pens on the 

interactive surface. 

IMPORTANT

If you have not used your interactive whiteboard before, you must perform a 

calibration. If the system detects incorrect calibration parameters, a warning 

bubble may also appear recommending that you perform a calibration. 

To calibrate the interactive

whiteboard

1. Click the SMART software icon in the Windows notification area or 

Mac Dock, and then click Control Panel. 

2. Select SMART Hardware Settings.

http://www.smarttech.com/kb/127199
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3. If you have more than one SMART product connected, select the appropriate 

interactive whiteboard.

4. Click Advanced Settings, and then click Calibrate. 

The Calibration window opens. This can take a few moments while your system 

sets up.

5. Use the tip of a pen tray pen to press the red targets as they appear. Move the tip 

to the center of each target until the target turns green, and then lift the pen. When 

you remove the pen, the target moves to the next calibration point. 

NOTE

You can re-calibrate a target by pressing the left arrow key on your keyboard, 

or the Keyboard or Right-click buttons on the pen tray.

6. Continue until you have pressed all the targets. 

When you’ve pressed all the targets, a message appears saying that the 

calibration was successful, and then the orientation screen appears. 

Orienting your interactive whiteboard
After you install SMART Product Drivers on your computer and calibrate your 

interactive whiteboard, an orientation screen appears. The 4-point orientation process 

ensures that the calibration coordinates are accurately associated with the relative 

location of your projected image on the interactive surface. The orientation data is 

saved in your interactive whiteboard. If you connect a different computer, the 

orientation data for your interactive whiteboard remains unchanged. 

Orient your interactive whiteboard if your projector or interactive whiteboard has 

moved since you last used it, or whenever the mouse pointer isn’t properly aligned 

with your finger or a pen tray pen when you touch the interactive whiteboard’s surface.
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To orient your

interactive whiteboard

1. Press the Orientation button on the pen tray (see page 20). 

The orientation screen opens.

2. Pick up a pen from the pen tray. 

3. Beginning at the upper-left corner of the screen, touch the center of the target 

firmly with the tip of the pen. When you remove the pen, the target moves to the 

next orientation point. Try not to flick the pen when you lift it from the interactive 

surface, and make sure that you lift it from the screen at a 90° angle.

NOTE

Although you can use your finger to orient your interactive whiteboard, 

a fine-point tool such as a pen tray pen provides greater precision when 

touching the targets. The more precisely you touch the targets, the more 

accurately your finger or pen tray pen appears on the interactive screen.

4. Repeat step 3 until you complete the orientation process.

The orientation screen closes.

NOTE

You can re-orient a target by pressing the left arrow key on your keyboard, or 

the Keyboard or Right-click buttons on the pen tray.

Poor orientation pointGood orientation point

The pen touches the center of the target.
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Connecting a guest laptop
If you want to connect a guest laptop without installing SMART Product Drivers on it, 

disconnect the USB cable from your resident computer, and then connect it to the 

laptop. You’ll immediately have touch control of the interactive whiteboard, but won’t 

be able to use digital ink. You’ll also need to connect a video cable between the laptop 

and projector. 

NOTE

With a laptop connected, the Ready light on your interactive whiteboard blinks 

until you install SMART Product Drivers. This is normal. See page 21 for more 

information about Ready light states.

You must also install SMART Product Drivers (see page 12) on your laptop if you 

want to use all the features of the interactive whiteboard.
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Chapter 4

Using and maintaining your 
SMART Board interactive 
whiteboard

In this chapter
Refer to these topics for information about using and maintaining your SMART 

Board X800 series interactive whiteboard.

Getting started ..................................................................................... page 19

Using the pen tray................................................................................ page 22

Using Ink Aware................................................................................... page 23

Updating SMART software .................................................................. page 23

Writing, selecting and erasing using object awareness ....................... page 24

Using gestures..................................................................................... page 24

Tips for trouble-free performance ........................................................ page 29

Keeping the writing surface clean........................................................ page 30

Getting started
Once your SMART Board X800 series interactive whiteboard is installed, the camera 

system is calibrated and the interactive surface has been oriented, you can begin 

using the interactive whiteboard to write, erase and move objects, open applications, 

use Ink Aware programs and save your notes on your computer.

Turning the interactive whiteboard on and off
To turn on your interactive whiteboard, ensure that you’ve connected the USB cable 

between the pen tray and your computer, and that the power cable is connected to a 

wall outlet, and then turn on your computer.
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If your interactive whiteboard is in standby mode, the Power button on the pen tray is 

unlit. Press the Power button to wake up your interactive whiteboard. Press the Power 

button again to return it to standby mode.

When you turn on or reset your interactive whiteboard, the indicator lights on the 

pen tray cycle twice. When the system is running and SMART Product Drivers is 

installed, the lights come on only for the ink color you select. The pen tray detects the 

removal of the pens and the eraser using infrared sensors.

Power panel controls and indicators
Located at the pen tray’s left side, the Power panel has Power, Orientation and Help 

buttons, and the interactive whiteboard’s Ready light.

Power button

Use the Power button to put your interactive whiteboard into standby mode when not 

in use, and to restore full power to the interactive whiteboard when you need to use it. 

Ensure that the interactive whiteboard is connected to your computer and to a wall 

power outlet.

Orientation button

Press this button to start the orientation process. Orienting your interactive whiteboard 

ensures that the mouse pointer or digital ink appears directly below your finger or pen 

tray tool when you touch the interactive surface. See page 16 for information on 

performing an orientation procedure.

Power 

button Orientation 

button

Help button

Ready light
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Help button

Press this button to access on-screen Help options, including links to online Help files, 

the SMART Connection wizard and contact information for SMART technical support.

Ready light

The Ready light is solid green when the system is operating correctly. 

The following table shows the Ready light’s normal states. If the indicator’s behavior 

doesn’t match a state listed here, see Troubleshooting tips on page 33.

Ready Light State Meaning

Solid red Your interactive whiteboard is receiving power from the 

power cable, but isn’t communicating with a computer.

Flashing green Your interactive whiteboard is receiving power and is 

communicating successfully with your computer’s USB HID 

driver. SMART Product Drivers isn’t installed.

NOTE

In HID mode, interactive whiteboard tools such as the 

pens and the eraser don’t work, but you can move the 

mouse pointer and perform mouse functions by 

touching the interactive surface. The Right-click button 

on the pen tray might work, depending on the version 

of operating system you’re using. Neither the Keyboard 

nor the Help button work in HID mode.

Solid green Your interactive whiteboard is receiving power and is 

communicating successfully with SMART Product Drivers.

Flashing amber The controller module is in a service mode or the firmware 

is being updated.
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Using the pen tray
In addition to providing a convenient place to hold the pens and the eraser, the pen 

tray on your SMART Board X800 series interactive whiteboard has several controls, 

sensors and indicators.

Pen tray buttons
In the center of the pen tray, 

there are six buttons. The 

middle four change the color 

of digital ink for the two pen 

tools. 

The buttons on either side of 

the pen color buttons default 

to the on-screen keyboard 

(left button) and right-click 

(right button) functions. 

You can customize the 

buttons using SMART Tools 

to provide several other 

functions, including printing, 

changing pages, launching 

applications and capturing the screen.

Pressing the Keyboard and Right-click buttons simultaneously starts the orientation 

process. 

Customizing your pen tray buttons
You can use the SMART control panel to customize your SMART hardware settings, 

including the pen, eraser and button settings.

To customize the button

settings

1. Press the SMART software icon in the Windows notification area or Mac Dock, 

and then select Control Panel.

The SMART control panel opens.

2. Press SMART Hardware Settings, select Pen and button settings from the 

drop-down list, and then select the button you want to customize.

Right-click button

Keyboard button

Pen color buttons
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For more information about customizing your settings, open the online Help by 

pressing the Help button on the pen tray, selecting Help Center, and then selecting 

SMART Hardware Settings.

Using Ink Aware
Ink Aware integrates SMART software with applications including Microsoft Word, 

Excel® or PowerPoint®. When you use an application that is Ink Aware, whatever you 

write or draw on your interactive whiteboard becomes embedded in the file, rather 

than an external note created over the file. 

To view a list

of Ink Aware programs

1. Press the SMART software icon in the Windows notification area or Mac Dock, 

and then select Control Panel.

The SMART control panel opens.

2. Press Configure SMART Tools.

3. Press Ink Aware Program Settings.

The Aware dialog box appears. You can enable or disable Ink Aware for any of 

the programs in the list.

Updating SMART software
After you install your SMART software, you can find more resources and updates at 

smarttech.com/support. You can also check for software updates with SMART 

Product Update by selecting Help > Check for Updates in the software.

For more information about the SMART software included with your interactive 

whiteboard, see the software’s Help files.

To check for software

updates

1. Start your SMART software program.

2. Press Help > Check for Updates.

If you don’t see the Check for Updates option, contact your network administrator.

3. Press the Update button beside the software you want to update. 

SMART software updates automatically.

http://www.smarttech.com/Support
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Writing, selecting and erasing using object 
awareness
Your SMART Board X800 series interactive whiteboard features object awareness, 

which means you can pick up a pen and write, select or erase without replacing the 

pen. SMART software interprets your intent when you press the interactive surface, 

based on both the type of tool you’re using and the size of the contact area.

• If you touch the interactive surface with the pen, SMART software identifies its 

reflective surface, and you write or draw in digital ink on the screen.

• If you touch the interactive surface with your finger, you perform a left click.

• If you touch the interactive surface with an eraser, your palm or the side of your 

hand, SMART software identifies a large contact area, and you erase digital ink 

from the screen.

Enabling the lockable pen option
If you want any touch on the interactive whiteboard’s surface to register as a specific 

tool, such as a pen, eraser, or Select tool, regardless of the size of the contact area, 

press one of the pen tray’s pen color buttons for at least three seconds to lock it. 

NOTE

The selected pen tray light blinks to indicate you’re using the lockable pen option.

For example, if you select the pen tool, pressing the screen with either a pen tray pen, 

your finger, the palm of your hand or any other object creates digital ink on the 

interactive whiteboard. Use the lockable pen option if your users are more comfortable 

using a larger object, such as a tennis ball, to write on the interactive whiteboard.

To unlock the pen, press any pen tray color button.

Using gestures
When you use SMART software, you can perform the following gestures on the 

interactive whiteboard’s surface. 

NOTE

Depending on which operating system and which application you’re working in, 

some gestures may not work or may perform differently than described.
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Selecting and deselecting an 
object (clicking)
Quickly press and release the interactive 

surface to select or deselect an object or 

option. This performs a standard mouse 

click.

NOTE

This gesture starts programs if your 

operating system is set to start 

applications on a single click.

Displaying menu options 
(right-clicking or Control-
clicking)
Press your finger to the screen for a few 

seconds to perform a right click.

Double-clicking
Quickly press and release the interactive 

surface twice in the same spot. This 

performs a standard double-click.

NOTE

This gesture starts programs if your 

operating system is set to start 

applications on a double click.

2×
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Dragging an object, scroll bar or window
Press the object, scroll bar or window on 

the interactive surface. Keep your finger 

on the object and slowly move it to its 

new position. When you reach the 

position you want, release your finger.

Erasing digital ink
Using your flattened hand, palm, or fist, 

press the interactive surface and move 

your hand across the area you want to 

erase.

Use a scrubbing motion to erase entire 

areas of digital ink.

NOTE

To erase a large area of ink, move 

your hand in a circle around the area 

you want to erase, and then tap the 

middle of the circle with your hand, 

palm or fist.
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Best practices for gestures and tools
Follow these guidelines when you use gestures and tools with your interactive 

product.

• Hold your fingers perpendicular (90°) to the interactive surface at the contact 

point.

• Keep your thumb and other fingers away from the interactive surface. They can 

generate unintentional commands.

90°

90°
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• Keep your other hand, elbows and loose clothing away from the interactive 

surface. They can generate unintentional commands.

• For “click” commands, quickly tap your finger on the interactive surface. Also, 

make sure you lift your finger far enough away from the interactive surface 

between presses so that your finger is out of the interactive whiteboard cameras’ 

view.

• For “erase” commands, use your flattened hand, palm or the bottom of your fist.

• When using the pen tray’s eraser, use the wide surface for large areas, and the 

smaller, angled surface for smaller areas. Don’t use the edge of the eraser 

because this could be interpreted incorrectly.
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Tips for trouble-free performance
• Connect your interactive whiteboard to a USB interface that’s recognized by the 

operating system.

• Don’t obstruct the cameras’ view of the interactive whiteboard’s surface or edges. 

For example, don’t place magnets, stickers or adhesive tape on the interactive 

surface, or rest any objects, including the pens, in the recess at the bottom of the 

interactive surface because this interferes with the corner cameras’ ability to 

detect your finger or pen tray tools.

Safety tips for teachers
• Tell students not to look directly at the light beam from the projector. Instead, 

encourage them to keep their backs to the projector when working at the 

interactive whiteboard. Before students turn to face the class, they should take a 

step sideways, out of the projector’s beam.

• Make sure that you don’t look directly into the projector’s beam. Keep your back to 

the class when you write over a projected image. Step to the side of your 

interactive whiteboard before you turn to face the class.

• Tell your students not to touch the projector because it can become extremely hot 

during normal operation.

• Don’t use a chair to increase a student’s reach. If your students are unable to 

reach the top of the interactive whiteboard, you might need to remount a 

wall-mounted unit at a lower position.

Preventing damage to your interactive whiteboard
Although your SMART Board interactive whiteboard’s surface is very durable, 

take the following precautions to prevent damage to the interactive surface and 

other components.

• Don’t use sharp or pointed objects, such as ballpoint pens or pointers, 

as writing tools.
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• Don’t use abrasive erasers or harsh chemicals to clean your product.

• Don’t set up and use your interactive whiteboard in an area with high levels of 

dust, humidity or smoke.

• Don’t use compressed air to clean the interactive whiteboard’s cameras because 

the force of the air could damage them.

Keeping the writing surface clean
With proper care, your SMART Board interactive whiteboard will provide years of 

trouble-free service. Follow these tips to keep the interactive whiteboard’s surface 

clean:

• Don’t spray cleaner directly onto the interactive whiteboard’s surface. Instead, 

spray a light amount of cleaner on a cloth and then gently wipe the interactive 

surface.

• Clean your interactive whiteboard at least every six months.

• Don’t allow excess cleaner to flow onto the frame’s reflective surfaces, or into the 

pen tray slots.

• The digital cameras located in the corners of the frame are protected from dust 

and dirt by windows. In extremely dusty environments, spray a household, 

alcohol-free glass cleaner, such as Windex® cleaner, on a cotton swab and rub it 

gently on the windows. Don’t use compressed air to clean the cameras.

IMPORTANT

• Turn your interactive whiteboard off before you clean it so that you do not 

scramble the desktop icons or inadvertently activate applications when you 

wipe the interactive surface.

• To view dirt or streaks more easily, set your projector to standby (lamp off) 

mode.

Cleaning the pen tray’s sensors
If the infrared sensors in the sides of the pen tools’ recesses become obstructed by 

dirt, moisten a cotton swab with a household glass cleaner, such as Windex, and then 

carefully clean the infrared transmitter and receiver.

Infrared sensors
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In this chapter
Refer to these topics for information about troubleshooting your SMART Board X800 

series interactive whiteboard.

Adjusting the projected image ............................................................. page 31

Resetting your interactive whiteboard.................................................. page 32

Troubleshooting tips ............................................................................ page 33

Troubleshooting using SMART Diagnostics ........................................ page 41

Where to find more information ........................................................... page 42

Contacting SMART Technical Support ................................................ page 43

Transporting your interactive whiteboard............................................. page 43

Removing the pen tray......................................................................... page 44

Adjusting the projected image
If your projector isn’t installed in a fixed location, you can correct many image 

problems by shifting your projector or adjusting its zoom lens. 

NOTES

• Adjust the image size and shape based on your projector’s splash screen, 

unless the splash screen image is much smaller than the computer’s 

projected image. Before you adjust the projected image, set the computer’s 

resolution and refresh rate (see page 13).

• Refer to your projector’s user’s guide for information on adjusting the 

projected image.
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Resetting your interactive whiteboard
If your interactive whiteboard behaves erratically or becomes unresponsive, possibly 

because of an electrostatic discharge, a power interruption or some other event, you 

might be able to restore normal operation by resetting your interactive whiteboard.

Reset your interactive whiteboard by pressing the Reset button on the bottom of the 

pen tray. The Reset button is recessed so that it can’t be triggered accidentally. Use a 

long, narrow object, such as a ball-point pen, to press this button.

You can also reset the interactive whiteboard by disconnecting and then reconnecting 

the power cable from the wall.

Using the Connection Wizard
You can resolve many troubleshooting issues using the SMART Connection Wizard 

found in the SMART control panel. 

To start the SMART

Connection wizard

1. Press the Help button on the pen tray. 

The Help and Support for Your SMART Board Interactive Whiteboard window 

opens.

2. Press Connection Wizard.

The SMART Connection Wizard opens.

TIP

You can also access the SMART Connection Wizard by selecting the SMART 

software icon in the Windows notification area or Mac Dock, selecting Control 

Panel, and then selecting Connection Wizard.

3. Select SMART Board X800 series interactive whiteboard, and then press 

Next.

4. Select the option that best describes the issue you’re encountering, and follow the 

on-screen instructions to troubleshoot your interactive whiteboard.

Reset button



33 | CHAPTER 4  – TROUBLESHOOTING YOUR SMART BOARD INTERACTIVE 
WHITEBOARD
Troubleshooting tips
Try the troubleshooting tips in this table if the Ready light indicates that your 

interactive whiteboard is operating normally, but you’re still encountering problems.

Symptom/observation Cause Solution

There is no image 

projected on your 

interactive whiteboard, 

or a “No Input” 

message appears.

Your projector isn’t 

receiving a video 

signal.

• Check the video cable 

connections.

• Check that the correct video input 

is selected on your projector. 

• Make sure your projector is on 

and that it’s connected to a power 

source and your computer.

• If you’re using a laptop computer, 

switch the external video 

connection on. Refer to your 

laptop’s user guide for more 

information.

Your computer is in 

standby mode.

Move the mouse or touch any key 

on your keyboard to bring your 

computer out of standby mode.

Your computer is off. Turn on or restart your computer.

The orientation screen 

doesn’t appear when 

you press the 

Orientation button.

The orientation 

screen is appearing 

on a different 

display.

Press the Orientation button again, 

or press the SPACEBAR on your 

keyboard until the Orientation 

screen appears.

The projected image is 

blurry, too large or 

doesn’t completely fill 

the whiteboard’s 

interactive surface.

Your projector’s 

position, zoom and 

focus settings aren’t 

adjusted.

Adjust your projector’s position, 

zoom and focus settings. Refer to 

your projector’s manual for more 

information.

Your computer’s 

video resolution 

settings don’t match 

your projector’s 

native resolution. 

Consult your projector’s manual for 

the correct video resolution, and 

then go to Windows Control Panel or 

the Mac System Preferences to 

change the video resolution to 

match your projector.
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The SMART software 

icon doesn’t appear in 

the Windows 

notification area or Mac 

Dock.

SMART Board Tools 

isn’t running.

Start SMART Board Tools.

For Windows computers, select 

Start > All Programs > SMART 

Technologies > SMART Product 

Drivers > SMART Board Tools. 

For Mac computers, select Finder > 

Applications > SMART Product 

Drivers > SMART Board Tools.

SMART Product 

Drivers isn’t 

installed.

Install SMART Product Drivers on 
your computer.

For details about installing SMART 

Product Drivers, see page 12.

Touch isn’t accurate. 

The pointer doesn’t 

appear directly below 

your finger. When you 

write on the interactive 

surface, your writing 

appears at a slight 

distance from the pen.

Your interactive 

whiteboard isn’t 

oriented properly.

Orient your interactive whiteboard.

To start the orientation, press the 

Orientation button on the pen tray 

(see page 15).

If the Orientation screen doesn’t 

appear, perform a calibration 

procedure as described on page 14.

Digital ink doesn’t 

appear on the 

interactive whiteboard 

or appears 

intermittently.

The interactive 

whiteboard isn’t 

calibrated properly.

Use SMART Board Diagnostics to 

confirm the issue, and then perform 

a calibration procedure. See 

page 41 for information.

Nothing happens when 

you touch the 

interactive whiteboard, 

even though the 

computer and projector 

are on.

A camera is 

obscured.

Remove any object attached to the 

interactive surface or resting in the 

bottom bezel behind the pen tray. 

Use SMART Board Diagnostics to 

confirm the issue and then clear the 

affected camera. See page 41 for 

information.

The interactive 

whiteboard is off.

Press the Power button on the 

interactive whiteboard’s pen tray to 

turn it on.

One of the pen color 

buttons is flashing.

You have selected 

the lockable pen 

option. See page 24 

for information.

Press any pen tray color button to 

exit the lockable pen option.

Symptom/observation Cause Solution

http://www2.smarttech.com/kbdoc/122239
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Troubleshooting using the Ready light
You can troubleshoot your interactive whiteboard using the Ready light, together with 

other observable symptoms and behaviors. Before you start troubleshooting, see 

page 20 to locate the Ready light, and then familiarize yourself with its states during 

normal operation.

The following flowchart directs you to the next stage in your troubleshooting process.

Ink always appears on 

the screen, even when 

you touch the 

interactive surface with 

a finger or the palm of 

your hand.

A pen is missing 

from the pen tray 

and Touch 

Recognition has 

been disabled.

Place all the pen tray tools in their 

slots and press the Help button on 

the pen tray. Select Touch 

Recognition Settings and ensure 

the Enable Touch Recognition box 

is selected.

You have selected 

the lockable pen 

option. See page 24 

for information.

Press any pen tray color button to 

exit the lockable pen option.

An error message 

appears when you try to 

calibrate your 

interactive whiteboard.

A camera isn’t 

properly connected 

or isn’t functioning 

correctly.

Contact SMART Technical Support 

(page 47).

Symptom/observation Cause Solution
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Flowchart 1: Getting started

Your interactive whiteboard isn’t 

receiving power. 

Your interactive whiteboard is receiving 

power but isn’t communicating correctly 

with your computer. 

A flashing green Ready light might be 

normal if you want touch-only operation 

of your interactive whiteboard. If you 

want to use the SMART Board tools or 

the pen tray pens, go to Flowchart 4.

A solid green Ready light indicates 

normal operation. To diagnose problems 

that might occur in other components of 

your interactive whiteboard, see 

Flowchart 5.

If the Ready light is flashing or steady 

amber, the firmware might be updating. 

Wait until it finishes. 

If none of these descriptions applies to the Ready light, contact your next level of 

support.
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Flowchart 2: Diagnosing power issues
If the Ready light is off, the interactive whiteboard isn’t receiving power. 

If the computer is in standby mode, the 

Power button on the pen tray is off. Press 

the Power button or touch the interactive 

surface to wake up the computer.

To reset the interactive whiteboard, use a 

long, narrow object, such as a ball-point 

pen, to press the recessed Reset button 

briefly (less than three seconds). 

Alternatively, disconnect the power cable 

from the wall, and connect it again.

When you reset the interactive whiteboard, 

all the pen tray lights flash sequentially 

twice, indicating successful communication 

with the controller. If they flash 

continuously, contact SMART Technical 

Support.

Check that the power cable is connected to 

the correct receptacle. The audio and 

power receptacles are located beside each 

other on the back of the pen tray.
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Flowchart 3: Ready light red
A red Ready light indicates that your interactive whiteboard is receiving power but isn’t 

communicating successfully with your computer. In most cases, pen tray lights don’t 

turn on and the screen isn’t responsive to touch.

The interactive whiteboard is 

connected to your computer with 

a USB cable and to the wall 

outlet with a power cable. You 

can access these cables by 

reaching under the pen tray.

If the Ready light changes from 

green to red while your computer 

is running, the computer can 

become unresponsive. Restart 

your computer.

To reset the interactive 

whiteboard, use a long, narrow 

object, such as a ball-point pen, 

to press the recessed Reset 

button briefly (less than three 

seconds). Alternatively, 

disconnect the power cable from 

the wall, and connect it again.
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Flowchart 4: Ready light is flashing green
This is the normal mouse mode state when SMART Product Drivers isn’t installed on 

your computer. This mode might be desirable for occasional or guest users who don’t 

require the use of SMART Board Tools or pen tray functions.

Install SMART Product Drivers 

from the disc or link included with 

your interactive whiteboard, or 

download it from smarttech.com/

downloads. 

To determine whether the 

SMART Board software service 

is running, open the SMART 

control panel and check the 

message that appears at the 

bottom. Start SMART Board 

software service if it isn’t running. 

To start SMART Board

Service

1. Press the SMART software icon in the Windows notification area or 

Mac Dock, and then press Control Panel.

The SMART control panel opens.

2. Select About Software and Product Support > Tools > Diagnostics.

The SMART Board Diagnostics window opens.

3. In the Service menu, select Start.

Ready light
is flashing

green

No

No

Yes

Yes

Yes

Contact your
next level of

support

Is SMART
Product Drivers

installed?

Is the
SMART

Board service
running?

Is the Ready
light flashing

green?

Install SMART
Product Drivers

10.7 or later

No

No

Start SMART
Board

Service

Reinstall
SMART Product

Drivers

Go to
Flowchart 1

http://www.smarttech.com/downloads
http://www.smarttech.com/downloads
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Flowchart 5: Ready light is green
A solid green light indicates that the interactive whiteboard is working correctly. 

However, if the pen tray tools don’t work as expected, or if the interactive whiteboard 

isn’t sensitive to touch, use the following flowchart to troubleshoot your interactive 

whiteboard. Use the SMART Board Diagnostics to further troubleshoot these issues 

(next page).

If another user has reassigned 

the pen, eraser or pen tray button 

functions, the tools might not work 

as expected. You can return them 

to normal operation by using the 

SMART control panel to change 

SMART hardware settings.

Use a soft cloth to dust the 

camera lens covers. Don’t use 

compressed air to clean the 

cameras or lens covers.

To reset the interactive 

whiteboard, use a long, narrow 

object, such as a ball-point pen, 

to press the recessed Reset 

button briefly (less than three 

seconds). Alternatively, 

disconnect the power cable from 

the wall, and connect it again.

Calibrate the cameras to ensure 

that they accurately track your 

finger and the pens. To calibrate 

the cameras, ensure your 

projector’s image fills as much of 

the interactive surface as 

possible, and then select View > 

SBX800/SBID8070i Bar > 

Calibrate.
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Troubleshooting using SMART Board 
Diagnostics
If you touch the interactive whiteboard’s surface and nothing happens, or if there is no 

digital ink or the ink appears in some locations and not in others, use SMART Board 

Diagnostics to help identify and resolve these issues.

IMPORTANT

Do not change diagnostic settings unless asked to do so by SMART Technical 

Support.

Checking the camera view
If nothing happens when you touch the interactive whiteboard’s surface, check to 

make sure that nothing is obscuring one of the cameras’ views.

To check camera views 1. Press the SMART software icon in the Windows notification area or 

Mac Dock, and then press Control Panel.

The SMART control panel opens.

2. Select About Software and Product Support > Tools > Diagnostics.

The SMART Board Diagnostics screen opens.

3. In the View menu, select SBX800/SBID8070i Bar.

The SBX800 group box appears in the SMART Board Diagnostics screen.

4. Press View.

The camera view screen appears.

5. Click Update to display the four cameras views. This may take a few moments. 

If one of the camera’s views remains black, the camera is obstructed or can’t 

locate the reflective surface on the interactive whiteboard’s inner frame. 

6. Check the camera lens and ensure that nothing is obscuring the view and that 

nothing is affixed to the interactive surface.

Normal camera 

views

Image when a pen or other object 

obscures the camera’s view
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Checking the interactive whiteboard’s calibration
If digital ink appears only in certain areas when you write on the interactive 

whiteboard, or no ink appears, the interactive whiteboard could be incorrectly 

calibrated. You can test the calibration using SMART Board Diagnostics.

To check the interactive

whiteboard’s calibration

1. Press the SMART software icon in the Windows notification area or 

Mac Dock, and then press Control Panel. 

The SMART control panel opens.

2. Select About Software and Product Support > Tools > Diagnostics.

The SMART Board Diagnostics screen opens.

3. In the View menu, select SBX800/SBID8070i Bar.

The SBX800 group box appears in the SMART Board Diagnostics screen.

4. Press Tracker.

The screen becomes white.

5. Move your finger around the interactive surface and watch the four pairs of 

colored lines. If the lines don’t converge on a single point, this indicates that the 

interactive whiteboard needs to be re-calibrated. 

NOTE

If one or more of the lines doesn’t move or doesn’t appear, this indicates that 

a camera is obstructed or isn’t working properly.

6. Press the ESC key to close the Tracker screen, and then press Calibration. 

7. Perform a calibration procedure (see page 14).

Finding more information
The Help Center contains links to a wide range of information, including procedures, 

concepts, help with applications, SMART software tool descriptions, troubleshooting 

hints and more. 

Access the Help Center by pressing the Help button on the pen tray. The Help button 

also provides access to the orientation screen and SMART contact information. For 

more information on the pen tray buttons, see page 22. Alternatively, you can access 

the Help Center from the SMART software icon in the Windows notification area or 

Mac Dock.
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Contacting SMART Technical Support
SMART Technical Support welcomes your call. Before contacting SMART Technical 

Support, make note of your SMART Board interactive whiteboard’s serial number, and 

then note it in the inside cover of this manual (if you printed it).

To determine your

interactive whiteboard’s

serial number

You can find the serial number in two places: on the back of your SMART Board 
interactive whiteboard, and on the bottom right-hand edge of your interactive 
whiteboard’s frame (the side).
 

The serial number on your SMART Board interactive whiteboard always begins with 

the letters SBX, followed by the interactive whiteboard’s model number, for example, 

SBX880-xx-xxxxxx. The serial number can include numbers, letters and hyphens.

NOTE

Make sure you include all the numbers, letters and hyphens in your serial number 

when contacting technical support.

Transporting your interactive whiteboard
Save your original SMART Board interactive whiteboard packaging so that it’s 

available if you need to transport your interactive whiteboard. When required, repack 

your interactive whiteboard with as much of the original packaging as possible. 

This packaging was designed with optimal shock and vibration protection. 

If you prefer to use your own packaging materials, make sure that you adequately 

protect your interactive whiteboard. Ship the unit in an upright position to deter 

shippers from placing heavy objects on it.

Serial number locations

Front view Rear view
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Removing the pen tray 
It might be necessary to remove the pen tray when you transport or service your 

interactive whiteboard. 

WARNING

There are no user-serviceable parts inside the pen tray. Do not disassemble the 

pen tray.

NOTE

You don’t need to wear ESD protection when performing the following procedure.

To remove the pen tray 1. Turn off your interactive whiteboard by disconnecting the power cable from the 

wall and unplugging the USB cable from your computer.

2. Remove the pens and the eraser from the pen tray.

3. Reach under the pen tray and disconnect the USB cable.

4. If you secured the pen tray to its brackets using two security screws as described 

on page 10, remove these screws.

5. If you secured the pen tray using a Kensington lock or similar device, unlock and 

remove the lock.

6. Reach under the pen tray and pull down on the two large plastic clips. Because 

the ends of these clips project slightly downwards, they’re easy to locate.

7. While applying downward pressure to the clips, gently slide the pen tray toward 

you until you can access the cables attached to the back of the pen tray.

8. Carefully disconnect all cables before completely removing the pen tray from the 

two L-shaped metal brackets.

Plastic clips
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Hardware environmental 
compliance

SMART Technologies supports global efforts to ensure that electronic equipment is 

manufactured, sold and disposed of in a safe and environmentally friendly manner.

Waste Electrical and Electronic Equipment 
regulations (WEEE Directive)
Waste Electrical and Electronic Equipment regulations apply to all electrical and 

electronic equipment sold within the European Union.

When you dispose of any electrical or electronic equipment, including SMART 

Technologies products, we strongly encourage you to properly recycle the electronic 

product when it has reached end of its life. If you require further information, please 

contact your authorized SMART reseller or SMART Technologies for information on 

which recycling agency to contact.

Restriction of Certain Hazardous 
Substances (RoHS Directive)
This product meets the requirements of the European Union’s Restriction of Certain 

Hazardous Substances (RoHS) Directive 2002/95/EC.

Consequently, this product also complies with other regulations that have arisen in 

various geographical areas, and that reference the European Union’s RoHS directive.

Packaging
Many countries have regulations restricting the use of certain heavy metals in product 

packaging. The packaging used by SMART Technologies to ship products complies 

with applicable packaging laws.

http://www.smarttech.com/us/Where+To+Buy
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China’s Electronic Information Products 
regulations
China regulates products that are classified as EIP (Electronic Information Products). 

SMART Technologies products fall under this classification and meet the 

requirements for China’s EIP regulations.

U.S. Consumer Product Safety 
Improvement Act
The United States has enacted the Consumer Product Safety Improvement Act which 

limits the lead (Pb) content in products used by children. SMART Technologies is 

committed to complying with this initiative.



Appendix B

Customer support

Online Information and Support
Visit www.smarttech.com/support to view and download user’s guides, how-to and 

troubleshooting articles, software and more.

Training
Visit www.smarttech.com/trainingcenter for training materials and information about 

our training services.

Technical Support
If you experience difficulty with your SMART product, please contact your local 

reseller before contacting SMART Technical Support. Your local reseller can resolve 

most issues without delay.

NOTE

To locate your local reseller, visit www.smarttech.com/where.

All SMART products include online, telephone, fax and e-mail support:

Online www.smarttech.com/contactsupport 

Telephone +1.403.228.5940 or

Toll Free 1.866.518.6791 (U.S./Canada)

(Monday to Friday, 5 a.m. – 6 p.m. Mountain Time)

Fax +1.403.806.1256

E-mail support@smarttech.com 

http://www.smarttech.com/support
http://www.smarttech.com/trainingcenter
http://www2.smarttech.com/st/en-US/Where+to+Buy/
http://www.smarttech.com/contactsupport
mailto:support@smarttech.com
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